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VISI DAN MISI PRODI INFORMATIKA 
 

 

VISI 

Menjadi program studi yang unggul dan inovatif dalam bidang rekayasa perangkat lunak dan sistem 

cerdas dengan dijiwai nilai-nilai Islam 

MISI 

1. Mengimplementasikan nilai-nilai AIK pada semua aspek kegiatan. 

2. Memajukan ilmu pengetahuan dan teknologi Rekayasa Perangkat Lunak dan Sistem cerdas 

melalui pendidikan, penelitian, dan pengabdian kepada masyarakat. 

3. Mengembangkan kerjasama dalam pendidikan, penelitian, dan pengabdian kepada masyarakat di 

tingkat lokal, nasional, maupun internasional. 

4. Menyelenggarakan tata kelola program studi yang unggul dan inovatif. 

5. Berperan aktif dalam kegiatan yang menunjang profesi dosen.   
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TATA TERTIB LABORATORIUM S1 INFORMATIKA 
 

 

DOSEN/KOORDINATOR PRAKTIKUM 
1. Dosen harus hadir saat praktikum minimal 15 menit di awal kegiatan praktikum untuk mengisi 

materi dan menandatangani presensi kehadiran praktikum. 

2. Dosen membuat modul praktikum, soal seleksi asisten, pre-test, post-test, dan responsi dengan 

berkoordinasi dengan asisten dan pengampu mata praktikum. 

3. Dosen berkoordinasi dengan koordinator asisten praktikum untuk evaluasi praktikum setiap 

minggu. 

4. Dosen menandatangani surat kontrak asisten praktikum dan koordinator asisten praktikum. 

5. Dosen yang tidak hadir pada slot praktikum tertentu tanpa pemberitahuan selama 2 minggu 

berturut-turut mendapat teguran dari Kepala Laboratorium, apabila masih berlanjut 2 minggu 

berikutnya maka Kepala Laboratorium berhak mengganti koordinator praktikum pada slot 

tersebut.  

 

PRAKTIKAN 
1. Praktikan harus hadir 15 menit sebelum kegiatan praktikum dimulai, dan dispensasi terlambat 15 

menit dengan alasan yang jelas (kecuali asisten menentukan lain dan patokan jam adalah jam yang 

ada di Laboratorium, terlambat lebih dari 15 menit tidak boleh masuk praktikum & dianggap Inhal). 

2. Praktikan yang tidak mengikuti praktikum dengan alasan apapun, wajib mengikuti INHAL, 

maksimal 4 kali praktikum dan jika lebih dari 4 kali maka praktikum dianggap GAGAL. 

3. Praktikan yang akan mengikuti inhal diwajibkan mendaftarkan diri dan membayar administrasi 

inhal kepada laboran inhal paling lambat H-1 jadwal inhal.  

4. Praktikan harus berpakaian rapi sesuai dengan ketentuan Universitas, sebagai berikut: 

a. Tidak boleh memakai Kaos Oblong, termasuk bila ditutupi Jaket/Jas Almamater (Laki-laki / 

Perempuan) dan Topi harus Dilepas. 

b. Tidak Boleh memakai Baju ketat, Jilbab Minim dan rambut harus tertutup jilbab secara 

sempurna, tidak boleh kelihatan di jidat maupun di punggung (khusus Perempuan). 

c. Tidak boleh memakai baju minim, saat duduk pun pinggang harus tertutup rapat (Laki-laki / 

Perempuan). 

d. Laki-laki tidak boleh memakai gelang, anting-anting ataupun aksesoris Perempuan. 

5. Praktikan tidak boleh makan dan minum selama kegiatan praktikum berlangsung, harus menjaga 

kebersihan, keamanan dan ketertiban selama mengikuti kegiatan praktikum atau selama berada 

di dalam laboratorium (tidak boleh membuang sampah sembarangan baik kertas, potongan kertas, 

bungkus permen baik di lantai karpet maupun di dalam ruang CPU). 

6. Praktikan dilarang meninggalkan kegiatan praktikum tanpa seizin Asisten atau Laboran. 

7. Praktikan harus meletakkan sepatu dan tas pada rak/loker yang telah disediakan. 

8. Selama praktikum dilarang NGENET/NGE-GAME, kecuali mata praktikum yang membutuhkan atau 

menggunakan fasilitas Internet. 

9. Praktikan dilarang melepas kabel jaringan atau kabel power praktikum tanpa sepengetahuan 

laboran 

10. Praktikan harus memiliki FILE Petunjuk praktikum dan digunakan pada saat praktikum dan harus 

siap sebelum praktikum berlangsung. 

11. Praktikan dilarang melakukan kecurangan seperti mencontek atau menyalin pekerjaan praktikan 

yang lain saat praktikum berlangsung atau post-test yang menjadi tugas praktikum.  
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12. Praktikan dilarang mengubah setting software/hardware komputer baik menambah atau 

mengurangi tanpa permintaan asisten atau laboran dan melakukan sesuatu yang dapat merugikan 

laboratorium atau praktikum lain. 

13. Asisten, Koordinator Praktikum, Kepala laboratorium dan Laboran mempunyai hak untuk 

menegur, memperingatkan bahkan meminta praktikan keluar ruang praktikum apabila dirasa anda 

mengganggu praktikan lain atau tidak melaksanakan kegiatan praktikum sebagaimana mestinya 

dan atau tidak mematuhi aturan lab yang berlaku. 

14. Pelanggaran terhadap salah satu atau lebih dari aturan diatas maka Nilai praktikum pada 

pertemuan tersebut dianggap 0 (NOL) dengan status INHAL. 

 

ASISTEN PRAKTIKUM 
1. Asisten harus hadir 15 Menit sebelum praktikum dimulai (konfirmasi ke koordinator bila 

mengalami keterlambatan atau berhalangan hadir). 

2. Asisten yang tidak bisa hadir WAJIB mencari pengganti, dan melaporkan kepada Koordinator 

Asisten. 

3. Asisten harus berpakaian rapi sesuai dengan ketentuan Universitas, sebagai berikut: 

a. Tidak boleh memakai Kaos Oblong, termasuk bila ditutupi Jaket/Jas Almamater (Laki-laki / 

Perempuan) dan Topi harus Dilepas. 

b. Tidak Boleh memakai Baju ketat, Jilbab Minim dan rambut harus tertutup jilbab secara 

sempurna, tidak boleh kelihatan di jidat maupun di punggung (khusus Perempuan). 

c. Tidak boleh memakai baju minim, saat duduk pun pinggang harus tertutup rapat (Laki-laki / 

Perempuan). 

d. Laki-laki tidak boleh memakai gelang, anting-anting ataupun aksesoris Perempuan. 

4. Asisten harus menjaga kebersihan, keamanan dan ketertiban selama mengikuti kegiatan 

praktikum atau selama berada di laboratorium, menegur atau mengingatkan jika ada praktikan 

yang tidak dapat menjaga kebersihan, ketertiban atau kesopanan. 

5. Asisten harus dapat merapikan dan mengamankan presensi praktikum, Kartu Nilai serta tertib 

dalam memasukan/Input nilai secara Online/Offline. 

6. Asisten mencatat dan merekap praktikan dengan status INHAL setiap minggu serta wajib 

mengumumkan mekanisme INHAL di awal pertemuan praktikum. 

7. Asisten harus dapat bertindak secara profesional sebagai seorang asisten praktikum dan dapat 

menjadi teladan bagi praktikan. 

8. Asisten harus dapat memberikan penjelasan/pemahaman yang dibutuhkan oleh praktikan 

berkenaan dengan materi praktikum yang diasisteni sehingga praktikan dapat melaksanakan dan 

mengerjakan tugas praktikum dengan baik dan jelas. 

9. Asisten tidak diperkenankan mengobrol sendiri apalagi sampai membuat gaduh. 

10. Asisten dimohon mengkoordinasikan untuk meminta praktikan agar mematikan komputer untuk 

jadwal terakhir dan sudah dilakukan penilaian terhadap hasil kerja praktikan. 

11. Asisten wajib untuk mematikan LCD Projector dan komputer asisten/praktikan apabila tidak 

digunakan. 

12. Asisten tidak diperkenankan menggunakan akses internet selain untuk kegiatan praktikum, seperti 

Youtube/Game/Medsos/Streaming Film di komputer praktikan.  

 

LAIN-LAIN 
1. Pada Saat Responsi Harus menggunakan Baju Kemeja untuk Laki-laki dan Perempuan untuk 

Praktikan dan Asisten. 

2. Ketidakhadiran praktikum dengan alasan apapun dianggap INHAL. 

3. Pelaksanaan (waktu dan metode) INHAL sama seperti praktikum mingguan/reguler. 
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4. Izin praktikum mengikuti aturan izin SIMERU/KULIAH. 

5. Yang tidak berkepentingan dengan praktikum dilarang mengganggu praktikan atau membuat 

keributan/kegaduhan. 

6. Penggunaan lab diluar jam praktikum maksimal sampai pukul 21.00 dengan menunjukkan surat 

ijin dari Kepala Laboratorium Prodi Informatika. 

 

 
 
 

Yogyakarta, 10 Juli 2023 
 

Kepala Laboratorium Praktikum 
S1 Informatika 

 
 
 

 
Murein Miksa Mardhia S.T., M.T. 

NIPM. 19891019 201606 011 1236278 
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SKENARIO PRAKTIKUM SECARA DARING 
 

Nama Mata Praktikum : Logika Informatika 

Jumlah Pertemuan : 10 materi 

 

TABEL SKENARIO PRAKTIKUM DARING 

 

Pertemuan 

ke 

Judul Materi Waktu 

(Lama 

praktikum 

sampai 

pengumpulan 

posttest) 

Skenario Praktikum  

(Dari pemberian pre-test, post-test dan 

pengumpulannya serta mencantumkan metode 

yang digunakan misal video, whatsapp group, 

Google meet atau lainnya) 

1 - 10 Sesuai materi di 

RPS 

180 menit 1. kelas google class room dibuat 
sesuai  jadwal praktikum yang sudah 
tersedia  (persesi).  

2. Jika satu kelas praktikum 40 
praktikan,  maka dibagi menjadi 4 
kelompok,  Kelompok praktikum dibagi 
menjadi 10  praktikan per room dengan 1 
asisten  pendamping untuk setiap 
kelompok.  

3.  Pret test diberikan selama 30 menit 
dengan menggunakan google form 
dan  toleransi waktu 10 menit  

4. Materi praktikum didistribusikan 
melalui  Google Class Room dalam bentuk 
PPT 5. 

5. Penyampaian materi akan dibuat 
video  penyampaian materi dengan durasi 
10  menit oleh asisten penanggung jawab 6. 

6. Pelaksanaan Praktikum diberikan 
dengan  mengerjakan sesuai langkah-
langkah  praktikum dengan durasi 60 menit. 

7. Post Test diberikan dan 
diselaikan  pengerjannya dengan durasi jam 
melalui  google class room dengan durasi 
80  menit. 

8. Tugas dosen pengampu: membuat soal  pre 
test, membuat soal 
response,  berkoordinasi dengan setiap 
asisten  sesuai sesi dan kelompoknya. 

9. Tugas asisten: membuat video  penjelasan 
materi, koreksi pre test,  pelaksanaan 
praktikum dan post test 
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PRAKTIKUM 1: PENGANTAR MAPLE DAN EKSPRESI LOGIKA 

 

Pertemuan ke  : 1 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 06-

P01 

Menguasai konsep teoitis bidang pengetahuan ilmu komputer/informatika secara 

umum dan konsep teoritis bagian khusus dalam bidang pengetahuan tersebut secara 

mendalam, serta mampu memformulasikan penyelesaian masalah prosedural 

CPMK-01 Mampu Menerapakan/memecahkan masalah yang berhubungan dengan basic logic. 

 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan:  

1. Mengenal Maple sebagai salah satu program aplikasi (software) untuk menyelesaikan persoalan-

persoalan terutama pada bidang Logika Informatika.  

2. Memahami bentuk-bentuk perangkai logika.  

3. Menggunakan proposisi ke bentuk simbolik dengan perangkai logika 

4. Dapat menerapkan cara penulisan suatu proposisi atau pernyataan ke dalam ekspresi logika 

dengan simbol logika ataupun mengguakan maple.  

1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 06-

P01 

CPMK -01 Mampu Menerapakan/memecahkan masalah yang berhubungan 

dengan basic logic. 

 

Indikator ketercapaian diukur dengan:  
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1. Memahami langkah-langkah pengoperasian Maple secara umum (toolbar, worksheet, help, 

executing commands dan lain-lain).  

2. Operator Logika, Ekspresi Logika dengan simbol dan Maple. 

 

1.3. TEORI PENDUKUNG  

1. Menu Utama  

Maple V memiliki menu-menu seperti yang ditampilkan pada gambar dibawah ini  

 

Gambar 1 Menu utama Maple 9.5 

Untuk melihat submenu yang ada di dalam menu utama Anda bisa menggunakan Mouse (Klik kiri 

mouse pada menu yang dipilih) atau tombol kombinasi Keyboard (Ex: Alt + F, untuk menu File dsb).  

2. Toolbar Standard  

Adalah salah satu area yang dimiliki Maple, yang berisi tombol-tombol yang digunakan untuk 

melakukan tugas-tugas umum. Jendela toolbar dapat disembunyikan atau ditampilkan.   

 

Gambar 2 Toolbar Maple 9.5 

Dari menu View, pilih Toolbar. Jika ada suatu cek yang menandai Toolbar, maka toolbar akan 

ditampilkan. Dan jika cek tersebut dihilangkan maka toolbar akan disembunyikan.  

3. Worksheet  

Adalah jendela kerja untuk menuliskan dokumen Maple.  

 

Gambar 3 Worksheet Maple 9.5 

4. Menggunakan Help  

Untuk menggunakan pertolongan, pilih menu Help dengan cara klik tombol kiri mouse. Dan pilih 

Type bantuan yang diperlukan. 
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Gambar 4 Struktur sub menu dibawah Help 

Sebagai contoh jika kita ingin mencari bagaimana menuliskan command/perintah dari fungsi 

Equivalent.   

Dari menu Help pilih Topic Search… Isikan pada kotak dialog Topic: Equivalent. Lalu Klik OK.   

 

 

Gambar 5 Kotak dialog Topic Search 

Lalu ditampilkan jendela hasil yaitu berupa refrensi dari fungsi equivalent seperti dibawah ini.  

 

Gambar 6 Referensi fungsi bequal 

Lalu jika ingin menggunakan fungsi “help”, langkah yang harus di lakukan yaitu klik pada help lalu 

pilih menu yang kita inginkan ,lihat contoh dibawah ini:  
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Gambar 7 Fungsi Help pada Maple 9.5 

Jika ingin menggunakan fungsi seperti pada Ms.Excell ,akan tampil seperti dibawah ini :  

 

Gambar 8 Fungsi Excel 

 

1. Operator Pemberian Nilai  

Operator yang sering digunakan adalah operator pemberian nilai.  Operator ini biasa dinyatakan 

dengan tanda =.  

2. Operator Aritmatik  

Operator ini hanya dapat dikenakan para operan bertipe bilangan bulat atau real.  

Tabel 1 Operator Aritmatik 

Operator  Operasi  Tipe operan  Tipe hasil  
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+ Penjumlahan  Bilangan bulat  
Bilangan real  

Bilangan bulat  
Bilangan real  

- Pengurangan  Bilangan bulat  
Bilangan real  

Bilangan bulat  
Bilangan real  

* Perkalian  Bilangan bulat  
Bilangan real  

Bilangan bulat  
Bilangan real  

/ Pembagian  Bilangan bulat  
Bilangan real  

Bilangan real  
Bilangan real  

divide  Pembagian 
bilangan bulat  

Bilangan bulat  Bilangan bulat  

mod   Sisa pembagian  
(modulus)  

Bilangan bulat  Bilangan bulat  

 

3. Operator Logika  

Dalam aljabar logika operator ini sangat sering digunakan. Sesuai namanya, operator ini dikenakan 

pada operan bertipe boolean.  Sehingga tipe operan dan tipe hasil operasinya adalah boolean. 

Beberapa operator boolean terlihat pada tabel berikut:  

Tabel 2 Operator Boolean 

Kata penghubung  Lambang  Operation  Maple  

Atau  ∨ Logika or  &or  

Dan  ∧ Logika and  &and  

jika ... maka ...  ⇒ Logika if..then..  &implies  

jika dan hanya jika  ⇔ Logika 
 if..and only if..  

&iff  

Tidak  ¬ Negasi  &not  

 

Pernyataan/statements/proposisi adalah kalimat deklaratif yang mempunyai satu dan hanya 

satu nilai dari dua nilai yang mungkin, yaitu Benar atau Salah (disebut nilai kebenaran).  Ditulis B (benar) 

/ T (True) atau S (salah) / F (false). 

Proposisi dibedakan atas  :  

a. Proposisi Atomik  

Proposisi yang tidak dapat dipecah lagi.   

Contoh :  

(1) Saya kuliah  

(2) Saya malas  

(3) Dosen memberikan kuliah  
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(4) Rektor membuka acara pelatihan  

b. Proposisi Majemuk  

Beberapa proposisi atomik yang digabungkan dengan perangkai tertentu. 

Contoh : 

(1) Jika saya malas kuliah maka saya tidak akan dapat nilai baik  

(2) Saya rajin berdiskusi dengan teman dan insyaAllah saya akan paham  

Variabel proposisional adalah huruf-huruf yang menggantikan proposisi-proposisi sebelumnya.  

Konstanta proposisional adalah nilai yang dimiliki oleh suatu proposisi, hanya ada 2 nilai, 

Benar/True dan Salah/False.   

Contoh proposisi majemuk berikut  :   

” Saya rajin berdiskusi dengan teman dan insyaAllah saya akan paham”, maka variabel 

proposisionalnya adalah huruf-huruf yang menggantikan proposisi tersebut, misal  :  

 

A =  Saya rajin berdiskusi  

B =  saya akan paham  

Yang mana masing-masing variabel proposisional memiliki nilai yang disebut dengan konstanta 

proposisional, misal  :  

A =  T atau  

B =  F  atau sebaliknya.  

Saya rajin berdiskusi dan saya akan paham dapat dinyatakan dengan 2 penulisan berikut, yaitu  :  

1. Ekspresi Logika; A ∧ B  

2. Ekspresi Maple;  A &and B  

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

a. Komputer. 

b. Maple 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 06-

P01 

CPMK-01 1. Tentukan apakah pernyataan dibawah ini merupakan 

proposisi Atomik atau Majemuk, dan tentukan perangkai 

logika yang digunakan: 

a. Pemuda itu tidak tinggi maupun tampan 

60 
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b. Pemuda itu tinggi, atau pendek dan tampan 

c. Tidak benar bahwa pemuda itu pendek maupun 

tampan 

d. Tidak benar bahwa pemuda itu pendek atau tidak 

tampan 

e. Pemuda itu tampan sekali. 

2. Sebutkan menu yang terdapat di Maple ! 15 

3. Sebutkan nama button dan fungsinya yang terdapat pada 

toolbar di Maple! 

25 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1.  CPL 06-

P01 

CPMK-01 Selesaikan langkah praktikum a. Hasil dokumentasi 

praktikum langkah a. 

30 

2.  Selesaikan langkah praktikum b 

dan c 

Hasil dokumentasi 

praktikum langkah b dan 

c. 

35 

3.  Selesaikan langkah praktikum d. Hasil dokumentasi 

praktikum langkah d. 

35 

 

2. Langkah – Langkah Praktikum 

a. Menjalankan Maple  

Untuk menjalankan Maple pada Sistem Operasi Windows, ikuti langkah berikut ini:  

Buka Maple dengan cara pilih menu Start | Programs | Maple  
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Gambar 9 Cara menjalankan Maple V dari menu Start 

Maka akan ditampilkan jendela Lembar Kerja Maple seperti dibawah ini.  

 

Gambar 10 Jendela worksheet Maple 9.5 

Dengan terbukanya Lembar Kerja, berarti sebagai tanda bahwa Anda telah siap untuk berkerja 

menggunakan Maple. Maple menampilkan prompt >. Simbol > ini digunakan untuk menuliskan teks 

atau operasi-operasi Maple. Operasi pada Maple diberikan dengan mengetikkan pada papan ketik 

setelah symbol >.   

b. Penulisan Operator Pemberian Nilai pada Maple  

Pemberian nilai pada Maple dilakukan menggunakan tanda := (bukan tanda =). Contoh: 

>A:=12; 

A:= 12 

Untuk menuliskan suatu string dengan cara memasukkan karakter apapun didalam sepasang 

tanda kutip ganda ( “ “ ). Panjang maksimum suatu string tergantung pada sistem yang digunakan. 
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Pada platform 32-bit, adalah 268,435,439 karakter; dan pada platform 64-bit, adalah 34,359,738,335 

karakter.  Contoh:  

>B:="Selamat datang di Maple"; 

:= "Selamat datang di Maple" 

 

c. Penulisan Operator Aritmatik pada Maple  

Cobalah beberapa operasi berikut:  

>64+128; 

192 

>16*4; 

64 

 >29/3; 

 7 

>divide(9,2,'b'); 

true 

>b; 

 

>modp(12,7); 

5 

>12 mod 7; 

-2 

>mods(12,7); 

-2 

>1/3 mod 7; 

-2 

 

d. Penulisan Operator Logika pada Maple  

Beberapa contoh dinyatakan pada tabel di bawah.  

Tabel 3 Ekspresi Logika dan Ekspresi Maple 

Proposisi Ekspresi 
Logika 

Ekspresi Maple 

Saya kuliah A A 

Saya malas B B 
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Saya presentasi C C 

Saya tidak kuliah ¬ A &notA 

Saya tidak malas ¬ B &not B 

Saya kuliah dan saya presentasi A ∧ C A &and C 

Saya kuliah atau saya malas A ∨ B A &or B 

Jika saya tidak kuliah maka saya tidak 
presentasi 

¬ A → ¬ C (&not A) 
&implies 
(&notC) 

Saya presentasi jika dan hanya jika 
saya kuliah 

C ↔ A C &iff A 

 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL-03 CPMK-01 Sebutkan dan jelaskan perbedaan dari with(Logic); dan 

with(Logic): ? 

50 

2. Ubahlah proposisi berikut ke dalam ekspresi logika dan 

ekspresi maple 

a. Jika saya tidak belajar maka saya tidak naik 

kelas,tetapi saya belajar jika dan hanya jika saya 

mood saja 

b. 14 di kali 5 dibagi 3 memiliki sisa bagi 3 

50 

 

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL-03 CPMK 01    

2. Praktik CPL-03 CPMK 01    

3. Post-test CPL-03 CPMK 01    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 1: PENGANTAR MAPLE DAN 

EKSPRESI LOGIKA 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 2: TABEL KEBENARAN 

 

Pertemuan ke  : 2 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 
 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 
 

Pemenuhan CPL dan CPMK: 

CPL 06-

P01 

Menguasai konsep teoitis bidang pengetahuan ilmu komputer/informatika secara 

umum dan konsep teoritis bagian khusus dalam bidang pengetahuan tersebut secara 

mendalam, serta mampu memformulasikan penyelesaian masalah prosedural 

CPMK-01 Mampu Menerapakan/memecahkan masalah yang berhubungan dengan basic logic. 

 

2.1 DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan:  

1. Mahasiswa semester 1 Informatika memahami nilai-nilai kebenaran operasi logika dengan 

menggunakan fungsi tabel kebenaran pada Maple. 

2. Mahasiswa mampu menggunakan fungsi-fungsi yang disediakan Maple, untuk menyelesaikan 

masalah-masalah yang berkaitan dengan Logika Boolean 

3. Mampu  menganalisa suatu proposisi majemuk valid atau tidak dengan tabel kebenaran 

2.2 INDIKATOR CAPAIAN PEMBELAJARAN 

CPL 06-

P01 

CPMK -01 Mampu Menerapakan/memecahkan masalah yang berhubungan 

dengan basic logic.  

Indikator ketercapaian diukur dengan: (sesuaikan dengan RPS) 

1. Memahami nilai kebenaran dalam operasi logika dengan menggunakan tabel kebenaran Tabel 

Kebenaran 

2. Membuktikan pernyataan majemuk valid atau tidak dengan tabel kebenaran. 
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2.3 TEORI PENDUKUNG 

Dengan melibatkan beberapa perangkai logika sebelumnya, maka beberapa proposisi dapat 

digabungkan menjadi satu proposisi.  Setiap proposisi baik atomik ataupun majemuk, harus memiliki  

nilai, True/Benar atau False/Salah.  Alat yang digunakan untuk memberikan nilai dengan aturan 

tertentu dinyatakan pada Tabel Kebenaran (Truth Table).  Tabel kebenaran menunjukkan secara 

sistematis satu demi satu nilai-nilai kebenaran sebagai hasil kombinasi dari proposisi-proposisi yang 

sederhana.  

Untuk melengkapi tabel kebenaran pernyataan, kita harus mengetahui dulu berapa banyak 

pernyataan yang termuat yang berlainan dalam tabel itu.  Langkah ini mutlak diperlukan agar tidak ada 

kemungkinan komposisi nilai kebenaran yang mungkin tak tertuliskan.   

Sebagai contoh, jika kita mempunyai dua pernyataan yang berlainan, maka kemungkinannya adalah:  

(1) Pernyataan pertama benar, pernyataan kedua benar  

(2) Pernyataan pertama benar, pernyataan kedua salah  

(3) Pernyataan pertama salah, pernyataan kedua benar  

(4) Pernyataan pertama salah, pernyataan kedua salah  

Dalam bentuk tabel kebenaran, keempat komposisi tersebut dapat terlihat di bawah ini :  

 

 

 

 

 

Tabel ini terdiri dari dua pernyataan tunggal yang berbeda, yakni A dan B.  Nilai kebenaran kedua 

pernyataan tersebut dinyatakan dengan huruf T jika True/Benar dan F jika False/Salah.  Dengan 

mengingat akan definisi operasi konjungsi, disjungsi, implikasi dan biimplikasi antara pernyataan A dan 

B, maka tabel kebenaran pernyataan sebagai hasil dari operasioperasi tersebut, berturut-turut sebagai 

berikut  :  

 

 

 

A B 

T T 

T F 

F T 

F F 
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Tabel 4. Tabel Kebenaran 5 Operasi 

Contoh :  

Nyatakan kebenaran untuk pernyataan berikut  :  

“Jika gejala seorang pasien adalah panas tinggi atau disertai dengan bercak merah maka 

kemungkinan diagnosanya adalah penyakit campak.” 

Pernyataan dapat dipecah menjadi 3 variabel proposisional, yaitu  :  

A : gejala seorang pasien adalah panas tinggi  

B : gejala seorang pasien disertai bercak merah  

C : kemungkinan diagnosanya adalah penyakit campak 

Ekspresi Logikanya adalah  :  

   (A V B)  →  C  

Maka nilai kebenaran dari pernyataan di atas dengan kombinasi nilai T dan F untuk setiap variabel 

dapat dinyatakan dengan Tabel Kebenaran di bawah  :  

Tabel 5.  Tabel Kebenaran (A V B)  →  C 

 

 

 

 

 

 

 

 

 

A B A Λ B A V B A →B A ↔ B ¬A 

T T T T T  T F 

T F F T F  F F 

F T F T T  F T 

F F F F T  T T 

A  B  C  A V B  (A V B)  →  C 

T T T T T 

T T F T T 

T F T T T 

T F F T T 

F T T T T 

F T F T T 

F F T F F 

F F F F T 
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2.4 HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Maple 

2.5 PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL-03 CPMK-01 1. Buat tabel kebenaran dengan semua kemungkinan nilai 

kebenaran dari ekspresi logika berikut : ¬a V (b Λ ¬ c) 

 

50 

2. (Kerjakan dengan Tabel Kebenaran)  Jika p dan q adalah 

pernyataan-pernyataan yang benar, sedangkan R dan S 

adalah pernyataan yang salah, maka pernyataan majemuk 

berikut yang bernilai salah adalah  : 

a. (p  →  r) ↔ (q  →  s) 

b. (r  →  p)   ↔ (s  →  q) 

50 

 

2.6 LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

 CPL-03 CPMK-01 Selesaikan langkah praktikum Hasil dokumentasi 

praktikum langkah a. 

100 

 

2. Langkah – langkah Praktikum 

Nilai kebenaran dapat diketahui dengan menggunakan fungsi TruthTable pada Maple.    

Contoh : A V B   

> with(Logic); 

[&and, &iff, &implies, &nand, &nor, &not, &or, &xor, BooleanSimplify, Canonicalize, 

Contradiction, Dual,  

Environment, Equal, Equivalent, Export, Implies, Import, Normalize, Random, Satisfy, 

Tautology, TruthTable] 

> T1:=TruthTable(A &or B,[A,B]); 

T1 := table([(false, true) = true, (true, true) = true, (false, false) = false, (true, false) = true]) 
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Jika A = true dan B = true, maka A V B akan menghasilkan nilai true dengan 

menggunakan fungsi di atas. 

> T1[true,true]; 

true 

Jika A = true dan B = false, A V B  =  true  

> T1[true,false]; 

true 

Jika A = true  B =  false maka A V B akan bernilai true 

> T1[false,true]; 

true 

> T1[false,false]; 

false 

Contoh :  

Cari nilai kebenaran dari Ekspresi Logika berikut :        

(A V B) Λ (C V D) 

Bila A bernilai True, B bernilai True, C bernilai False dan D bernilai False, maka nilai kebenaran dari 

ekspresi logika tersebut dapat dinyatakan dengan Maple, yaitu  :  

> T2:=TruthTable((A &or B) &and (C &or D),[A,B,C,D]); 

T2 := table([(true, false, false, false) = false, (false, false, false, true) = false, (false, true, true, 

true) = true,  

(false, true, true, false) = true, (true, true, true, true) = true, (false, true, false, true) = true,  

(false, false, false, false) = false, (false, true, false, false) = false, (true, true, false, false) 

= false, (true, false, true, true) = true, (true, false, false, true) = true, (false, false, true, 

true) = false, (true, true, true, false) = true, (true, true, false, true) = true, (false, false, 

true, false) = false, (true, false, true, false) = true]) 

> T2[true,true,false,false]; 

false 
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2.7 POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL-03 CPMK-01 Bila terdapat pernyataan berikut  :  Jika seseorang ingin 
wawasannya luas, maka ia harus rajin membaca dan ia 
juga harus sering bertukar pikiran dengan orang lain. 

a. Ubah ke dalam ekspresi logika (10 point) 
b. Ubah ke dalam ekspresi maple (10 point) 
c. Nyatakan nilai-nilai kebenaran dari ekspresi 

tersebut dengan tabel ( 20 point) 
d. Buktikan kebenaran bagian c. dengan perintah 

maple (20 point) 

50 

2. (Kerjakan dengan Maple)  Jika p dan q adalah 

pernyataan-pernyataan yang benar, sedangkan R dan 

S adalah pernyataan yang salah, maka pernyataan 

majemuk berikut yang salah adalah  : 

a. (p → r) ↔ (q  →  s) (10 point) 

b. (r  →  p)   ↔ (s  →  q) (10 point) 

c. (~s V q) ↔ (~r V p) (10 point) 

d. (~p V q) ↔ (~r Λ s) (10 point) 

50 

 

2.8 HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 06-P01 CPMK 01    

2. Praktik CPL 06-P01 CPMK 01    

3. Post-test CPL 06-P01 CPMK 01    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 2: TABEL KEBENARAN 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 3: EVALUASI VALIDITAS ARGUMEN 

 

Pertemuan ke  : 3 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 06-

P01 

Menguasai konsep teoitis bidang pengetahuan ilmu komputer/informatika secara 

umum dan konsep teoritis bagian khusus dalam bidang pengetahuan tersebut secara 

mendalam, serta mampu memformulasikan penyelesaian masalah prosedural 

CPMK-02 Mampu menerapkan teknik pembuktiani validitas suatu proposisi dengan implikasi, 

ekivalensi, tautologi, konvers , Invers dan Kontradiksi   

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan dapat:  

1. Mengevaluasi validitas argumen dengan menggunakan fungsi tautology pada Maple  

2. Mengevaluasi validitas argumen dengan menggunakan fungsi kontradiksi pada Maple  

3. Mengevaluasi validitas argumen dengan menggunakan fungsi kontingen pada Maple  

 

1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 06-

P01 

CPMK -02 Mampu menerapkan teknik pembuktiani validitas suatu proposisi 

dengan implikasi, ekivalensi, tautologi, konvers , Invers dan Kontradiksi   

Indikator ketercapaian diukur dengan:  

1. Mengevaluasi vaiditas argumen dengan menggunakan fungsi tautologi 
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2. Mengevaluasi validitas argumen dengan kontradiksi 

3. Mengevaluasi validitas rgumen dengan kontingen  

 

1.3. TEORI PENDUKUNG 

a. Tautologi  

  Argumen yang validitasnya dibuktikan dengan tabel kebenaran harus menunjukkan semuanya 

bernilai benar.  Jika hasilnya benar, maka argumen tersebut valid, jika tidak maka sebaliknya.  Jika pada 

tabel kebenaran untuk semua pasangan nilai variabel-variabel proposisional yang ada bernilai benar 

atau T, maka disebut tautologi. 

 Contoh  :  

 ”Jika gejala seorang pasien adalah panas tinggi, maka kemungkinan penyakitnya adalah campak.  

Jika timbul bercak merah, maka kemungkinan penyakitnya adalah campak.  Dengan demikian, Jika 

gejala seorang pasien adalah panas tinggi atau timbul bercak merah, maka kemungkinan 

penyakitnya adalah campak.”  Nyatakan validitas dari argumen tersebut.    

Diubah ke variabel proposional yang atomik  :  

A = gejala seorang pasien adalah panas tinggi   

B = kemungkinan penyakitnya adalah campak   

C = timbul bercak merah  

Diubah lagi menjadi ekspresi logika yang terdiri dari premis dan kesimpulan 

Ekspresi logika 1 dan 2 adalah premis-premi, sedangkan ekspresi logika 3 adalah  

kesimpulan.  

 (1) Premis : A → B  

 (2) Premis : C → B  

 (3) Kesimpulan : (A V C) → B  

maka dapat ditulis :  

 ((A → B) Λ (C → B)) → ((A V C) → B)  

kemudian buat tabel kebenaran dari ekspresi logika tersebut :   



39 
 

Logika Informatika - Informatika – UAD - 2023 
 

Tabel 6 Pembuktian Validitas Argumen 

 

1. Tautologi  

Pada kolom terakhir dari tabel tersebut tautologi karena dihasilkan nilai T untuk semua baris 

kombinasi.  Dari hasil ini dapat disimpulkan bahwa argumen valid.  

2. Kontradiksi   

Kebalikan dari tautologi adalah kontradiksi, di mana semua pasangan nilai dari tabel kebenaran 

menghasilkan nilai F.  

3. Kontingen   

Jika semua nilai kebenaran menghasilkan nilai F dan T, maka terjadi kontingen.  Argumen yang 

memiliki nilai kebenaran kontingen, harus memilah nilai kebenaran hanya pada T, pada kasus ini 

argumen tetap dianggap tidak valid, karena yang bukan tautologi dianggap tidak valid. 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

a. Komputer. 

b. Software Maple 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

A B C A → B C → B (A → B) Λ (C → B) A V C (A V C) → B) P Λ  Q  → S 

   
( P ) ( Q ) ( P Λ  Q ) ( R ) R → B 

 

       
( S ) 

 
T T T T T T T T T 

T T F T T T T T T 

T F T F F F T F T 

T F F F T F T F T 

F T T T T T T T T 

F T F T T T F T T 

F F T T F F T F T 

F F F T T T F T T 
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CPL 06-

P01 

CPMK-02 1. (Kerjakan dengan tabel kebenaran)  Nyatakan tautologi, 

kontradiksi atau kontingen 

a) A → (B → A) 

b) (A → B) → C 

50 

2. Jika terdapat argumen berikut :  Buktikan argumen 

tersebut valid atau tidak dengan prinsip tautologi. 

a) Jika saya makan, maka saya kenyang.  Saya tidak 

makan.  Dengan demikian, saya tidak kenyang. 

b) Jika IP >= 3,00 maka mahasiswa tersebut dapat 

mendaftarkan diri untuk ikut beasiswa.  IP >= 3,00.  

Dengan demikian, mahasiswa tersebut dapat 

mendaftarkan diri untuk ikut beasiswa. 

50 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1. CPL 

06-

P01 

CPMK-

02 

Selesaikan langkah praktikum a. Hasil dokumentasi praktikum 

langkah a. 

30 

2. Selesaikan langkah praktikum 

b dan c 

Hasil dokumentasi praktikum 

langkah b dan c. 

35 

3. Selesaikan langkah praktikum 

d. 

Hasil dokumentasi praktikum 

langkah d. 

35 

2. Langkah – Langkah Praktikum 

Fungsi Tautologi  

tautology  

Bentuk umum perintah :  

  tautology(b)  

tautology(b,'p')  

Parameter:  

 b -  suatu ekspresi Boolean  

 p - (opsional) nama yang tak dievaluasi   

Pengujian tautologi atau bukan dari suatu ekspresi Boolean. Jika b suatu tautologi, true yang akan 

dikembalikan. False dikembalikan jika b bukan tautologi.    

Operator logik yang digunakan adalah :  
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&not   berarti negasi,  

&and   berarti ^,  

&or   berarti v,   

&implies  berarti ⇒,  

&iff   berarti ⇔,  

&nor,  

&nand,  

&xor 

 

Contoh :  

1. Untuk mengevaluasi validitas argumen (A Λ B)  V  (¬ A V  ¬B) dapat dituliskan seperti berikut  :  

> with(Logic):  

> Tautology(&and(a,b) &or (&not a) &or (&not b));  

True  

Dihasilkan nilai ‘True’ yang menandakan argumen valid.  Dapat dibuktikan dengan tabel 

kebenaran.  

2. Untuk mengevaluasi validitas argumen (A ↔ B) V B dapat dituliskan seperti berikut  :  

> Tautology((a &iff b) &or b,'p');  

False  

Dihasilkan nilai ‘False’ yang menandakan argumen tidak valid. 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-

KU01 

CPMK-02 (Kerjakan dengan Maple)  Nyatakan sifat argumen 

berikut  : 

a) A → (B → A) 

b) ((A → B) ↔ (¬A V B)) 

c) ((A → B) Λ (B → C)) → (A →C) 

 

75 

2. (Kerjakan dengan Maple)  Nyatakan argumen berikut 

dalam ekspresi logika, ekspresi maple dan nyatakan 

sifat argumen valid atau invalid 

25 
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“ Jika kita sungguh-sungguh cinta kepada Allah, 

maka kita akan mengikuti segala perintahNya atau 

menghindari laranganNya.  Jika kita selalu ingat 

kepada Allah, maka akan timbul ketenangan rasa 

dan ketentraman batin dalam hati.  Ternyata tidak 

timbul ketenangan rasa.  Jadi, jika kita sungguh-

sungguh cinta kepada Allah, maka akan timbul 

ketentraman batin dalam hati.” 

 

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-02    

2. Praktik CPL 03-

KU01 

CPMK-02    

3. Post-test CPL 03-

KU01 

CPMK-02    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 3: EVALUASI VALIDITAS 

ARGUMEN 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 4: EKUIVALENSI LOGIS 

 

Pertemuan ke  : 4 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 06-

P01 

Menguasai konsep teoitis bidang pengetahuan ilmu komputer/informatika secara 

umum dan konsep teoritis bagian khusus dalam bidang pengetahuan tersebut secara 

mendalam, serta mampu memformulasikan penyelesaian masalah prosedural 

CPMK-02 Mampu menerapkan teknik pembuktiani validitas suatu proposisi dengan implikasi, 

ekivalensi, tautologi, konvers , Invers dan Kontradiksi  

 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan:  

1. Dapat memahami ekuivalensi logis dan mampu memanfaatkan fungsi-fungsi Maple untuk 

mengetahui ekuivalensi suatu pernyataan. 

 

1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 06-

P01 

CPMK -02 Mampu menerapkan teknik pembuktiani validitas suatu proposisi 

dengan implikasi, ekivalensi, tautologi, konvers , Invers dan Kontradiksi  
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Indikator ketercapaian diukur dengan:  

1. Memahami Ekuivalensi Logis dari suatu pernyataan yang berbeda dengan menggunakan fungsi-

fungsi maple. 

 

1.3. TEORI PENDUKUNG 

A. Ekuivalensi  

  Argumen dikatakan ekuivalen satu sama lain jika memiliki urutan nilai kebenaran yang sama 

pada tabel kebenaran.  Lambang ekuivalen dinyatakan dengan tanda “ ≡ “.  

 Contoh buktikan ekuivalensi argumen berikut :    

(1)  Jika gejala penyakitnya adalah panas tinggi maka diagnosa penyakitnya adalah campak  

(2) Gejala penyakitnya bukan panas tinggi atau diagnosa penyakitnya adalah campak.  

Ekspresi logika dari argumen tersebut adalah :  

(1)  A  →  B  

(2) ¬ A V B  

Maka nilai kebenaran dari argumen dapat dilihat pada tabel kebenaran :  

Tabel 7 Tabel Ekuivalensi 2 pernyataan 

 

Pada kolom nilai kebenaran A  →  B dan ¬ A V B dapat dilihat bahwa  urutan nilai kebenaran kedua 

ekspresi tersebut sama, artinya A  →  B ≡ ¬ A V B. 

 

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Maple 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 
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CPL CPMK No. Pertanyaan Skor 

CPL 06-

P01 

CPMK-02 1. Nyatakan ekspresi logika berikut ekuivalen atau tidak 

(dengan tabel kebenaran). 

a) A → (~A → B) Ξ 1 

b) A → B Ξ ~(A  ~B) 

100 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1.  CPL 06-

P01 

CPMK-03 Selesaikan langkah praktikum Hasil dokumentasi 

praktikum 

100 

 

2. Langkah-langkah Praktikum 

Fungsi Ekuivalen Equivalent adalah ekuivalensi logik dari dua ekspresi. 

Bentuk umum perintah :  

Equivalent(b1,b2)  

 Equivalent(b1,b2,'p')  

Parameter :  

b1,b2  - ekspresi Boolean   

p - (optional) unevaluated name  

 

Contoh :  

1. Untuk membuktikan ekuivalensi A  →  B dan  ¬ A V B   

> Equivalent(A &implies B, (&not A) &or B)  

   True 

Nilai True menandakan A  →  B ≡ ¬ A V B seperti halnya ditunjukkan pada tabel kebenaran, 

bahwa urutan nilai kebenaran pada dua ekspresi logika tersebut sama.  

 

2. Buktikan ekspresi logika berikut ekuivalens A Λ (A V B) dan  A 

> Equivalent(a &iff (a &or b),b &implies a);  

    True 

Nilai True menyatakan A ↔ (A V B)  ≡ B  ->  A 

 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 



47 
 

Logika Informatika - Informatika – UAD - 2023 
 

No CPL CPMK Pertanyaan Skor 

1. CPL 06-

P01 

CPMK-02 (Dengan Maple)  Yang ekuivalen dengan pernyataan  :  

“jika senja telah tiba, burung camar melayang-layang” 

adalah  : 

a) Senja telah tiba dan burung camar melayang-

layang 

b) Jika burung camar melayang-layang, maka senja 

telah tiba 

c) Senja belum tiba atau burung camar melayang-

layang 

d) Senja belum tiba atau burung camar tidak 

melayang-layang 

60 

2. (Dengan Maple)  Nyatakan kesamaan atau 

ketidaksamaan kalimat berikut, atau tentukan kalimat 

lain yang sama dengan kalimat pertama (bagian a) 

a) Tidak mungkin halnya bahwa seorang ibu 

mencelakai dan  tidak menyayangi anak 

kandungnya sendiri   

b) Seorang ibu yang tidak menyayangi anak 

kandungnya sendiri atau tidak akan mungkin 

mencelakai. 

40 

 

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 06-P01 CPMK-02    

2. Praktik CPL 06-P01 CPMK-02    

3. Post-test CPL 06-P01 CPMK-02    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 4: EKUIVALENSI LOGIS 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 5: PENYEDERHANAAN HUKUM LOGIKA 

 

Pertemuan ke  : 5 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-03 Mampu menganalisa penyederhanaan pola argumen logis dengan penyederhanaan 

dan mengimplementasikan gerbang logika. 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa mampu:  

1. Memahami hukum-hukum logika,  

2. Memahami prinsip penyederhanaan ekspresi logika dengan hukum-hukum logika. 

3. membuat penyederhanaan ekspresi logika dengan hukum logika dan pola argumen logis. 

4. Memanfaatkan fungsi-fungsi maple untuk menyelesaikan proses penyederhanaan. 
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1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -03 Mampu menganalisa penyederhanaan pola argumen logis dengan 

penyederhanaan dan mengimplementasikan gerbang logika. 

 

Indikator ketercapaian diukur dengan: (sesuaikan dengan RPS) 

1. Mampu menyederhanakan suatu ekspresi logika dengan prinsip penyederhanaan 

2. Mampu menyederhanakan suatu ekspresi logika dengan hukum logika. 

 

1.3. TEORI PENDUKUNG 

Dalam logika proposisi terdapat beberapa hukum atau sifat operasinya,yakni: 

Hukum-hukum logika 

dentitas p ˄ 1 ≡ p P ˅ 0 ≡ p 

Ikatan P ˅ 1 ≡ T P ˄ 0 ≡ 0 

Idempotent P ˅ p ≡ p P ˄ p ≡ p 

Negasi p˅p ≡ 1 p˄p ≡ 0 

Negasi Ganda ¬¬p ≡ p 
 

Komutatif p˅q ≡ q˅p p˄q ≡ q˄p 

Asosiatif (p˅q)˅r ≡ p˅(q˅r) (p˄q) ˄r ≡ p˄ (q˄r) 

De Morgans’ ¬(p˅q) ≡ ¬p˄¬q ¬(p˄q) ≡ ¬p˅¬q 

distributif p˅ (q˄r) ≡ (p˅q) ˄ (p˅r) p˄(q˅r) ≡ (p˄q)˅(p˄r) 

Absorbsi P˅(p˄q) ≡ p p˄(p˅q) ≡ p 

 

Dalam tautologi, nilai kebenaran dapat diganti sebagai berikut: 

True (T) ≡ 1 

False (F) ≡ 0 

Sekarang dapat dicoba pada tabel kebenaran berikut : 

 

Dengan melihat nilai pada tabel kebenaran dapat disimpulkan bahwa: 

A˄1 ≡ A 
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A˄0 ≡ 0 

Dengan tabel kebenaran juga dapat dibuktikan bahwa: 

A˅1 ≡ 1 

A˅0 ≡ A 

 

Jika   hasil   penyederhaan   bernilai1,   maka   tergolong tautologi.   Jika   0   maka   tergolong  

kontradiksi,  sedangkan  jika  hasilnya  tidak  1  ataupun  0,  maka  tergolong contingent.  Hasil  

penyederhanaan sudah tidak memungkinkan proses manipulasi dilanjutkan. 

Contoh: 

1. (A˅0) ˄ (A˅¬A) ≡ A ˄ (A˅¬A) hk. Identitas 
≡ A ˄ 1  hk. Negasi 

≡ A  hk. Identitas 

2. (A˄¬B) ˅ (A˄B˄C)  ≡ (A˄¬B) ˅ (A˄(B˄C))  tambah kurung 
≡ (A ˄ (¬B˅(B˄C)) hk. Distributif 

≡ (A ˄ (¬B˅B)˄(¬B˅C)) hk. Distributif 

≡ (A ˄ (1˄(¬B˅C)) hk. Negasi 

≡ (A ˄ (¬B˅C)) hk. Identitas 

3. (A˅B)˄¬A˄¬B  ≡ ¬A˄(A˅B)˄¬B   hk. Komutatif 
≡ (¬A˄(A˅B))˄¬B tambah kurung 

≡ ¬A˄(B˄¬B)   hk. Asosiatif 

≡ ¬A˄0    hk. Negasi 

≡ 0    hk. Ikatan 

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Maple 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 
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CPL 03-
KU01 

CPMK-03 1. (Dengan Teorema Penyederhanaan)  Sederhanakan 
bentuk logika berikut : 

a.  A Λ (¬A → A) 
b.  (A Λ B) V (¬A Λ B) Ξ B 
c.  ¬ (¬A Λ (B V ¬ B)) 
d.  ¬A → ¬ (A → ¬ B) 

 

100 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1.  CPL 03-

KU01 

CPMK-03 Selesaikan langkah praktikum Hasil dokumentasi 

praktikum 

100 

 

2. Langkah-langkah Praktikum 

Fungsi Menyederhanakan Ekspresi Boolean  

 Bentuk umum perintah :  

BooleanSimplify(b)  

 Parameter:  

b - suatu ekspresi Boolean    

Contoh  :   

1. Perintah menyederhanakan ekspresi logika ¬ (¬ A)  

> BooleanSimplify (&not (&not a));  

  a 

a adalah hasil penyederhanaan dari ¬ (¬ A), sesuai dengan hukum Double Negation dan 

pembuktian dengan tabel kebenaran.  

2.  Perintah menyederhanakan ekspresi logika A V ( A ∧ B) ∧ C  

Hasil nya?  

hasil penyederhanaan dari A V ( A ∧ B) ∧ C, sesuai dengan hukum ......... dan pembuktian 

dengan tabel kebenaran.  

3.  Perintah menyederhanakan ekspresi logika ¬ (¬ A ∧ ¬ B) V C∧ D 

Hasil nya? 
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hasil penyederhanaan dari ¬ (¬ A ∧ ¬ B) V C∧ D, sesuai dengan hukum ......... dan pembuktian 

dengan tabel kebenaran. 

 

 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-

KU01 

CPMK-03 1. Buktikan hasil penyederhanaan yang sudah 

dikerjakan pada pretest sebelumnya dengan 

Maple. 

2. Buktikan bahwa pola argumen logis hypothetical 

syllogism dan disjunctive syllogism adalah 

tautologi atau ≡ 1, dengan menggunakan 

penyederhanaan pada Maple. 

 

100 

  

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-03    

2. Praktik CPL 03-

KU01 

CPMK-03    

3. Post-test CPL 03-

KU01 

CPMK-03    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 5: PENYEDERHANAAN HUKUM 

LOGIKA 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 6: PENYEDERHANAAN DENGAN ALJABAR BOOLEAN 

 

Pertemuan ke  : 6 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

  

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-03 Mampu menganalisa penyederhanaan pola argumen logis dengan penyederhanaan 

dan mengimplementasikan gerbang logika. 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan mampu : 

1. Memahami hukum-hukum logika dengan aljabar boolean,  

2. Menyederhanakan pola argumen logis dengan penyederhanaan dan Mengimplementasikan 

fungsi aljabar boolean. 

3. Memanfaatkan fungsi-fungsi maple untuk menyelesaikan proses penyederhanaan Aljabar 

boolean. 
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1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -03 Mampu menganalisa penyederhanaan pola argumen logis dengan 

penyederhanaan dan mengimplementasikan gerbang logika. 

 

Indikator ketercapaian diukur dengan: (sesuaikan dengan RPS) 

1. Mampu menyederhanakan suatu ekspresi logika dengan prinsip penyederhanaan aljabar Boolean 

 

1.3. TEORI PENDUKUNG 

Aljabar Boolean merupakan alat yang bermanfaat untuk penyederhanaan dalam sebuah 

digital. 

Contoh :  

Fungsi rangkaian berikut dapat disederhanakan menjadi  :  

Ekspresi Booleannya :  Y = A * B  +  A * B’  +  A’ * B  

Pernyataan logika :  Y = (A ∧ B) ∨ (A ∧∼B) ∨ (∼A ∧ B)  

Minimalisasikan : 

Y = (A ∧ B) ∨ (A ∧∼B) ∨ (∼A ∧ B)       

   = A ∧ (B ∨∼B) ∨ (∼A ∧ B)    

   = A ∨ (∼A ∧ B)    

   = (A ∨∼A ) ∧ (A ∨ B)    

   = 1 ∧ (A ∨ B)    

         = (A ∨ B)   = A + B  

 Terlihat bahwa fungsi bisa direduksi (disederhanakan) menjadi hanya dua term, dan bisa 

diimplementasikan dengan gerbang yang lebih sederhana. Meskipun keduanya mengimplementasikan 

fungsi yang sama.  Jika diperlukan bisa digunakan tabel kebenaran untuk membuktikan bahwa dua 

implementasinya kuivalen.  Sebagaimana diperlihatkan pada tabel berikut :  

 

Terbukti bahwa nilai fungsi yang dihasilkan sama seperti nilai fungsi yang  dihasilkan pada 

proses sebelum penyederhanaan.    
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  Y  = A * B  +  A * B’  +  A’ * B 

Tabel 8. Output dari Y = A * B  +  A * B’  +  A’ * B 

 

Pernyataan logika:  

 Y  =  (A ∧ B) ∨ (A ∧∼B) ∨ (∼A ∧ B)  

Minimalisasikan pernyataan :  

 Y  = (A ∧ B) ∨ (A ∧∼B) ∨ (∼A ∧ B)   

     = A ∧ (B ∨∼B) ∨ (∼A ∧ B)   

     = A ∨ (∼A ∧ B)   

     = A + (∼A * B) 

Tabel 9. Output setelah disederhanakan 

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Maple 
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1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 03-

KU01 

CPMK-03 1. Diketahui ekspresi Boolean F = X’YZ + X’YZ’ + XZ  

a. Buat table kebenarannya 

b. Sederhanakan ekspresi Boolean 

c. Buktikan dengan table kebenarannya 

100 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

3.  CPL 03-

KU01 

CPMK-03 Selesaikan langkah praktikum Hasil dokumentasi 

praktikum 

100 

 

2. Langkah-langkah Praktikum 

Fungsi Menyederhanakan Ekspresi Boolean  

 Bentuk umum perintah :  

BooleanSimplify(b)  

 Parameter:  

b - suatu ekspresi Boolean    

Contoh  :   

1. Perintah menyederhanakan ekspresi boolean Y = A * B  +  A * B’  +  A’ * B 

a. Meminimalisasikan menjadi ekspresi logika, maka akan menjadi : 

Y = (A ∧ B) ∨ (A ∧∼B) ∨ (∼A ∧ B) 

> BooleanSimplify ((A &and B) &or ( A &and (&not B)) &or ((&not A) &or B));  

  (A &and B) 

Jika dirubah menjadi ekspresi Boolean, maka Y = A + B 
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2.  Perintah menyederhanakan ekspresi boolean Y = A’B’C’ + A’B’C + ABC’   

Hasil nya?  

hasil penyederhanaan dari A’B’C’ + A’B’C + ABC’, sesuai dengan hukum ......... dan 

pembuktian dengan tabel kebenaran.  

3.  Perintah menyederhanakan ekspresi boolean Y = A’B + AB + A’B’  

Hasil nya? 

hasil penyederhanaan dari A’B + AB + A’B’ ,sesuai dengan hukum ......... dan pembuktian 

dengan tabel kebenaran. 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-

KU01 

CPMK-03 Bila diketahui suatu ekspresi boolean berikut  : 

 F = XZ + X’Y + YZ 

a)  Implementasikan fungsi di atas dengan gerbang-

gerbang logika dan buat tabel kebenarannya 

b)  Sederhanakan ekspresi boolean tersebut 

b) Implementasikan ekspresi boolean yang sudah 

disederhanakan dengan gerbang logika dan buat 

tabel kebenarannya 

 

 

 

 

50 

 

50 

  

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-03    

2. Praktik CPL 03-

KU01 

CPMK-03    
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3. Post-test CPL 03-

KU01 

CPMK-03    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 6: PENYEDERHANAAN 

DENGAN ALJABAR BOOLEAN 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 7: PENYEDERHANAAN DENGAN KARNAUGH MAP 

 
Pertemuan ke  : 7 
 
Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 
 
Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 
 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-03 Mampu menganalisa penyederhanaan pola argumen logis dengan penyederhanaan 

dan mengimplementasikan gerbang logika. 

 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa mampu :  

1. Memahami penyederhanaan dengan Karnaugh Map dan implementasi nya untuk menyelesaikan 

persoalan-persoalan terutama pada bidang Logika Informatika. 

2. Menerapkan cara mengerjakan K-Map yang disediakan di aplikasi Karnaugh Map Minimizer untuk 

menyelesaikan suatu masalah. 

 

1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -03 Mampu menganalisa penyederhanaan pola argumen logis dengan 

penyederhanaan dan mengimplementasikan gerbang logika. 

 

Indikator ketercapaian diukur dengan: 

1. Memahami langkah-langkah pengoperasian K-Map. 
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2. Dapat menganalisa dan menyelesaikan kasus penyederhanaan dengan Kmap. 

 

1.3. TEORI PENDUKUNG 

A.  Karnaugh Map 

K-MAP atau Karnaugh Map adalah suatu teknik penyederhanaan fungsi logika dengan cara 

pemetaan. 

Jenis-Jenis Kmap : 

1. Kmap 2-variabel 

2. Kmap 3-variabel 

3. Kmap 4-variabel 

Bentuk canonic dalam K-Map : 

1. Sum Of Products (SOP) 

SOP ekspressi Boolean yang dilakukan dengan cara menggabungkan beberapa nilai 1 

(minterm). 

2. Products Of Sum (POS) 

POS ekspressi Boolean yang dilakukan dengan cara menggabungkan beberapa nilai 0 (maxterm). 

Peta Karnaugh (K-map) menyediakan cara sistematik dan grafis untuk mencari rangkaian SOP 

dan POS minimal I K-map SOP I mengelompokkan minterm-minterm bernilai 1 yang saling berdekatan, 

yang hanya mempunyai perbedaan di satu variabel saja I membentuk rangkaian AND-OR I K-map POS 

I mengelompokkan Maxterm-Maxterm bernilai 0 yang saling berdekatan I membentuk rangkaian OR-

AND minimal. I K-map juga merupakan alternatif untuk menyatakan suatu fungsi logika selain tabel 

kebenaran dan ekspresi logika I K-map disusun atas sel-sel. Satu sel, satu minterm. 

 

Minterm-minterm yang berdekatan dapat dikombinasikan karena mereka hanya berbeda di satu 

variabel saja, disebut Grouping I Grouping dilakukan dengan melingkari nilai ’1’ yang berdekatan I 

Melingkari dua nilai ’1’ bersama, berarti mengeliminasi satu term dan satu variabel dari ekspresi 

output I Variabel yang dieliminasi adalah yang mempunyai perbedaan nilai di grup, vertikal/horizontal 

I Group merah: x1 dieliminasi, Grup biru: x2 dieliminasi. 
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Hanya dapat mengkombinasikan nilai 1 yang berdekatan I Hanya dapat menggabungkan 2n 

minterm (1,2,4,8,16, dst) I Bentuk grup sebesar mungkin I grup 2 minterm menghilangkan 1 variabel I 

grup 4 minterm menghilangkan 2 variabel I grup 8 minterm menghilangkan 3 variabel I Group yang 

sudah dicover oleh group lain tidak perlu digabungkan lagi. 

Dari sebuah K-map, implementasi rangkaian logika bisa mempunyai dua bentuk, yaitu: 1. Jika 

diinginkan rangkaian logika dengan AND-OR atau NAND-NAND, maka persamaan logika SOP minimal 

dapat diperoleh dengan mengelompokkan minterm bernilai 1; 2. Jika diinginkan rangkaian logika 

dengan OR-AND atau NOR-NOR, maka persamaan logika POS minimal dapat diperoleh dengan 

mengelompokkan Maxterm bernilai 0; 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Maple 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 03-

KU01 

CPMK-03 1. Sederhanakan:  

a. f (x1, x2) = ∑m(0, 3) dan 

b. f (x1, x2) = ∑m(1, 2) 

50 

CPL 03-

KU01 

CPMK-03 2. Sederhanakan f (x1, x2, x3) = ∑m(0, 1, 2, 5) 25 

CPL 03-

KU01 

CPMK-03 3. Sederhanakan fungsi f (x1, x2, x3, x4) = πM(0, 2, 4, 8 − 12, 

14) dengan K-map 

25 

 

 

 



65 
 

Logika Informatika - Informatika – UAD - 2023 
 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1.  CPL 03-

KU01 

CPMK-03 Selesaikan langkah praktikum 1. 

K-Map 2 variabel 

Hasil dokumentasi 

praktikum 

30 

2.  CPL 03-

KU01 

CPMK-03 Selesaikan langkah praktikum 2. 

K-Map 3 variabel 

Hasil dokumentasi 

praktikum 

35 

3.  CPL 03-

KU01 

CPMK-03 Selesaikan langkah praktikum 3. 

K-Map 4 variabel 

Hasil dokumentasi 

praktikum 

35 

 

3. Langkah-langkah Praktikum 
 

Buka software k-map minimizer 

 

1. Kmap 2-variabel 

Contoh Kasus : 

Fungsi F(A,B) = AB’ + AB 

SOP (Sum Of Products) 

Langkah 1 :  

Pastikan Type of solution : Sum Of Product 

Langkah 2 :  
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Atur Number Of Variables : 2 

Langkah 3 : 

 Jika yang bernilai 1 itu (A) jika yang bernilai 0 itu (A’) Begitupun dengan B. 

Langkah 4 :  

- Masukkan nilai 1 pada baris kedua, kolom pertama untuk mengisi mengisi fungsi A.B’.  

- Masukkan nilai 1 pada baris kedua, kolom pertama untuk mengisi fungsi A.B 

kemudian klik solve. 

 

 

Maka Fungsi Minterm nya : F(A,B) = Ʃm(2,3). 

POS (Products Of Sum) 

Langkah – langkahnya sama seperti SOP yang diatas tetapi yang diganti hanya Type Of 

Solution menjadi : Products Of Sum 
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Maka Fungsi Maxterm nya : F(A,B) = Ʃm(0,1). 

Latihan: 

Sederhanakan Fungsi F dibawah ini dengan peta karnaugh 

Fungsi F(A,B) = A’B + AB + A’B’ 

2. Kmap 3-variabel 

Contoh Kasus :  

Fungsi F(A,B,C) = A’B’C’ + A’BC + AB’C’ + AB’C 

SOP (Sum Of Products) 

Langkah 1 :  

Pastikan Type of solution : Sum Of Product 

Langkah 2 : 

 Atur Number Of Variables : 3 

Langkah 3 : 

Jika yang bernilai 1 itu (A) jika yang bernilai 0 itu (A’) Begitupun dengan B dan C. 

Langkah 4 :  

- Masukkan nilai 1 pada baris pertama kolom keempat untuk mengisi fungsi A’.B’.C’ ,  

- Masukkan nilai 1 pada baris pertama kolom ketiga untuk mengisi fungsi A’.B.C  

- Masukkan nilai 1 pada baris kedua kolom pertama untuk mengisi fungsi A.B’.C’ ,  

- Masukkan nilai 1 pada baris kedua kolom kedua untuk mengisi fungsi A.B’.C , Kemudian klik solve. 

 

 

Maka Fungsi Minterm nya : F(A,B,C) = Ʃm(2,3,4,5). 
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POS (Products Of Sum) 

Langkah – langkahnya sama seperti SOP yang diatas tetapi yang diganti hanya Type Of Solution menjadi 

: Products Of Sum. 

 

Maka Fungsi Maxterm nya : F(A,B,C) = Ʃm(0,1,6,7). 

Latihan  :  

Sederhanakan Fungsi F dibawah ini dengan peta karnaugh 

1. Fungsi F(A,B,C) =  A’B’C + A’B’C’ + ABC + ABC’ 

 

3. Kmap 4-variabel 

Contoh Kasus : 

Fungsi F(A,B,C,D) = A’B’CD + A’BCD + ABC’D + AB’C’D 

SOP (Sum Of Products) 

Langkah 1 :  

Pastikan Type of solution : Sum Of Product 

Langkah 2 :  

Atur Number Of Variables : 4 

Langkah 3 :  

Jika yang bernilai 1 itu (A) jika yang bernilai 0 itu (A’) Begitupun dengan B, C dan D. 

Langkah 4 :  
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- Masukkan nilai 1 pada baris pertama kolom ketiga untuk mengisi fungsi A’B’CD ,  

- Masukkan nilai 1 pada baris kedua kolom ketiga untuk mengisi fungsi A’BCD ,  

- Masukkan nilai 1 pada baris ketiga kolom kedua untuk mengisi fungsi ABC’D , 

- Masukkan nilai 1 pada baris keempat kolom kedua untuk mengisi fungsi AB’C’D , 

Kemudian klik solve. 

 

Maka Fungsi Minterm nya : F(A,B,C,D) = Ʃm(3,7,9,13). 

POS (Products Of Sum) 

Langkah – langkahnya sama seperti SOP yang diatas tetapi yang diganti hanya Type Of Solution menjadi 

: Products Of Sum. 

 

Maka Fungsi Maxterm nya : F(A,B,C,D) = Ʃm(0,1,2,4,5,6,8,10,11,12,14,15). 
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1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. 

 

 

 

CPL 03-

KU01 

CPMK-03 Sederhanakan Fungsi F dibawah ini dengan 

menggunakan peta karnaugh : 

a. Fungsi F(A,B) = A’B + AB + A’B’ 

b. Fungsi F(A,B,C) =  A’B’C + A’B’C’ + ABC + ABC’ 

c. Fungsi F(A,B,C,D) =  A’BC’D’ + A’B’C’D’ + AB’CD’ + 

AB’CD 

 

 

25 

25 

50 

 

  

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-03    

2. Praktik CPL 03-

KU01 

CPMK-03    

3. Post-test CPL 03-

KU01 

CPMK-03    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 7: PENYEDERHANAAN DENGAN 

KARNAUGH MAP 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 8: GERBANG LOGIKA 

 

Pertemuan ke  : 8 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-03 Mampu menganalisa penyederhanaan pola argumen logis dengan penyederhanaan 

dan mengimplementasikan gerbang logika. 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa mampu :  

1. Memahami notasi pada Gerbang Logika dan implementasi nya untuk menyelesaikan persoalan-

persoalan terutama pada penyederhanaan ekspresi Logika Informatika. 

2. Menyederhanakan pola argumen logis dengan penyederhanaan dan  

3. Mengimplementasikan fungisi K-Map dengan gerbang logika menggunkan aplikasi DSCH2 untuk 

menyelesaikan suatu masalah. 
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1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -03 Mampu menganalisa penyederhanaan pola argumen logis dengan 

penyederhanaan dan mengimplementasikan gerbang logika. 

 

Indikator ketercapaian diukur dengan: 

1. Memahami langkah-langkah pengoperasian DSCH2. 

2. Dapat menganalisa dan menyelesaikan kasus penyederhanaan dengan Gerbang Logika. 

 

1.3. TEORI PENDUKUNG 

A.  Gerbang Logika 

Gerbang Logika merupaka dasar pembentukan sistem digital. Gerbang Logika beroperasi pada 

bilangan biner 1 dan 0. Gerbang logika digunakan dalam berbagai rangkaian elektronik dengan sistem 

digital. Berkaitan dengan tegangan yang digunakan maka tegangan tinggi berarti 1 dan tegangan 

rendah berarti 0. 

Diantara beberapa Gerbang Logika yang dikenal, terdapat beberapa Gerbang Logika dasar, yang dalam 

penerapannya nanti bisa dikembangkan menjadi gerbanggerbang logika yang lain. Gerbang dasar 

tersebut adalah : 

1. Gerbang OR 

3. Gerbang AND  

4. Gerbang NOT (Inventer)  

 

Gambar 11 Gerbang (a) OR, Gerbang (b) AND, dan Gerbang (c) NOT 

Dari gerbang-gerbang logika tersebut dibentuk gerbang-gerbang logika lain, misalnya NOR yaitu 

gabungan dari gerbang OR dan NOT, sedangkan gerbang NAND adalah gabungan dari gerbang AND 

dan gerbang NOT dan seterusnya. 

 

Gambar 12 Gerbang (a) NOR dan Gerbang (b) NAND 

Selain itu ada juga jenis gerbang logika yaitu Gerbang Logika Exclusive. Gerbang Logika Exclusive hanya 

ada OR dan NOR. Simbol pada umumnya seperti yang ada di bawah ini. 
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Gambar 13 Gerbang (a) XOR dan Gerbang (b) XNOR 

 

B. DSCH2 

DSCH2 merupakan perangkat lunak aplikasi yang menyediakan fasilitas editor logika dan simulator 

logika. Dengan program ini Anda dapat menyusun rangkaian logika melalui editor logika dan 

sekaligus  mengujinya melalui simulator logika. Perancang perangkat lunak ini adalah Prof.Etienne 

SICARD dari Jurusan Teknik Elektro dan Komputer  pada The National Institute of Applied Sciences, 

Toulouse, Perancis.  

Pengoperasian DSCH2 tidak memerlukan prosedur yang rumit. Program ini dapat berjalan pada 

komputer dengan sistem operasi Windows 95, 98, NT, maupun XP,dan memori minimum 16 

Mbyte.  Silahkan download di sini untuk memperoleh DSCH2. Lakukan extract all terhadap semua file 

yang telah anda download. Untuk menjalankan program ini, Anda cukup menyalin folder DSCH2 

beserta seluruh isinya ke harddisk komputer Anda. Setelah Anda menyalin folder tersebut, jalankan 

Windows Explorer untuk mencari file aplikasi DSCH2. Untuk menjalankannya, klik double pada icon

, sehingga diperoleh tampilan seperti pada Gambar4. 

 

Gambar 14 Tampilan awan DSCH2 

 

C. PENJELSAN MENU DSCH2 

http://www.insa-toulouse.fr/
http://www.insa-toulouse.fr/
http://muchlas.ee.uad.ac.id/downloads/DSCH2.zip
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Menu File: 

1. Klik pada File > New merupakan perintah untuk memulai DSCH2 dengan layar bersih. Rangkaian 

digital yang sedang dirancang harus disimpan terlebih dahulu sebelum memberikan perintah ini 

karena semua informasi tentang gambar yang sedang dirancang akan dihapus dari memori. Tidak 

ada fasilitas Undo atau pembatalan untuk perintah New. 

2. Klik pada File > Open atau pada ikon  merupakan perintah untuk membuka file. 

Nilai defaultdari ekstensi file yang akan dibuka adalah .SCH yang  merupakan file skema rangkaian 

(schema). Selain ekstensi .SCH dapat pula dipilih ekstensi  lain seperti .SYM untuk file simbol. 

3. Save/Save as 

• Klik pada File > Save atau pada ikon adalah perintah untuk menyimpan gambar skema 

rangkaian  mengunakan nama yang sedang aktif. Nama default yang diberikan adalah 

” EXAMPLE.SCH “ 

• Perintah dengan klik pada  File > Save as digunakan untuk menyimpan rancangan dengan 

nama baru. Akibat dari perintah ini akan memunculkan jendela baru untuk memasukkan nama 

rancangan. Nama rancangan ditulis dengan keyboard diikuti dengan klik pada  Save. Dengan 

perintah tersebut, rancangan Anda akan disimpan dengan ekstensi .SCH. 

4. Select Foundry 

Klik pada File > Select Foundry merupakan perintah untuk memilih teknologi komponen yang 

digunakan. Perintah tersebut akan memunculkan daftar teknologi komponen yang dapat dipilih 

dan secara otomatis akan menampilkan nama “default.tec”. 

5. Make Verilog File 

Merupakan perintah membuat deskripsi verilog yang berguna untuk menyusun gambar skema ke 

dalam layout menggunakan program Microwind. Deskripsi verilog adalah teks yang mengandung 

informasi modul (nama, input, output), hubungan internal, daftar komponen maupun parameter 

simulasi. 

6. Schema to new Symbol 

Klik pada File > Schema to New Symbol atau pada ikon digunakan untuk menyusun simbol 

yang didefinisikan sendiri oleh user (pengguna) yang umumnya dirancang dengan menggunakan 

rancangan hierarkis. Sebagai contoh, rangkaian full adder yang disusun dengan menggunakan 

gerbang-gerbang logika dasar dapat diubah ke dalam bentuk simbol tunggal yang memiliki input 

dan output seperti pada gambar berikut ini. 
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Gambar 15 Tampilan menu Scheme to Symbol 

• Klik pada tombol I/Os merupakan perintah untuk menampilkan daftar pin atau terminal input 

dan output yang dapat berupa tombol, clock, LED, keypad, dan lainnya. Anda dapat mengubah 

letak pin input dan output dengan mengubah-ubah Position dan Side yang ada pada tabel. 

Notasi yang digunakan untuk kolom Side adalah L (left) menunjukkan sisi kiri, R (right) sisi 

kanan, U (up) sisi atas, dan D (down) sisi bawah. 

• Klik pada Verilog merupakan perintah untuk menghasilkan teks dalam format verilog yang 

menunjukkan deskripsi dari komponen-komponen penyusun simbol maupun deskripsi dari 

simbol itu sendiri. 

• Klik Refresh adalah perintah menampilkan perbaikan (update) dari tata letak simbol yang 

dirancang oleh user. 

• Anda dapat mengatur ukuran simbol dengan klik pada ikon untuk memperbesar 

dan  untuk memperkecil simbol. 

• Nama simbol dapat Anda ubah dengan mengisi Title pada kotak Symbol Properties, dan nama 

file yang akan disimpan dapat Anda tuliskan pada baris Name.  

7. Properties 

Perintah File>Properties menyediakan beberapa informasi seperti persentase memori yang 

digunakan oleh gambar skema rangkaian mencakup jumlah simbol, node dan line. 

8. Monochrome/Colors 

Tombol ini digunakan untuk mengubah mode tampilan dari berwarna ke hitam-putih dan 

sebaliknya. 

9. Print Schema 
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• Klik pada  File > Print Schema digunakan untuk mencetak gambar skema rangkaian yang ada 

pada layar ke printer. Cara lain dapat dilakukan dengan menyalin tampilan pada layar 

ke clipboarddengan menekan tombol keyboard Alt+Print Screen. Buka editor teks atau editor 

grafik Anda, kemudian klik Edit > Paste. 

• Pada saat Print Schema dipilih, secara otomatis DSCH2 akan mengubah mode tampilan layar 

ke monokrom. 

10. Leave Dsch2 

Klik pada  File > Leave Dsch2 merupakan perintah untuk kembali ke Windows dengan 

menampilkan pesan konfirmasi penyimpanan data dari rangkaian yang sedang dirancang. 

 

D. SIMBOL GERBANG LOGIKA DIGITAL 

NAMA SIMBOL GRAFIK FUNGSI 

ALJABAR 

TABEL 

KEBENARAN 

DIGRAM DSCH2 

AND 

 
 

 

 

OR 

 
 

 

 

INVERTER 

 
  

 

BUFFER 
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NAND 

 
 

 

 

NOR 

  

 

 

XOR 

 

 

 

 

XNOR 

 

 

 

 

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software DSCH2 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 03-

KU01 

CPMK-03 1. Diketahui ekspresi Boolean F = X’YZ + X’YZ’ + XZ  

a. Gambar Rangkaian logikanya 

b. Buat table kebenarannya 

c. Sederhanakan ekspresi Boolean 

d. Gambar rangkaian setelah disederhanakan 

 

20 

20 

20 

20 
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e. Buktikan dengan table kebenarannya 

 

20 

 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1.  CPL 

03-

KU01 

CPMK-03 Selesaikan percobaan 1 Hasil dokumentasi praktikum 30 

2.  CPL 

03-

KU01 

CPMK-03 Selesaikan percobaan 2 Hasil dokumentasi praktikum 35 

3.  CPL 

03-

KU01 

CPMK-03 Selesaikan percobaan 2 Hasil dokumentasi praktikum 35 

 

2. Langkah-langkah Praktikum 

PERCOBAAN 1 

Buatlah skema rangkaian AND pada simulator DSCH2, dengan langkah-langkah sebagai berikut : 

a. Buka software DSCH2 dengan klik double icon , maka anak muncul tampilan seperti 

berikut : 

 

Gambar 16 Tampilan menu awal DSCH 
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b. Pilih symbol untuk inputan dan symbol untuk operasi AND, kemudian pilih  

untuk output, lalu konekan semua penghubung, sehingga jadi rangkaian seperti gambar 

dibawah ini :  

 

Gambar 17 Tampilan rangkaian AND di DSCH 

c. Setelah rangkai jadi, klik tombol simulator  untuk me-run sehingga muncul tampilan 

seperti berikut : 

 

Gambar 18 Tampilan Running simulator rangkaian AND di DSCH 

 

d. Lalu masukan inputan pada rangkaian berdasarkan Tabel Kebenaran pada Tabel 10. Cara 

pengujiannya jika lampu menyala pada inputan 1 (in1) berarti nilai inputannya 1, 

sedangkan jika lamput tidak menyala pada inputan 2 (in2) berarti nilai inputannya 0. Untuk 

output jika lamput output (out1) menyala berarti nilai kebenarnnya 1, sedangkan jika tidak 

menyala berarti 0. Sepert pada gambar dibawah ini : 

   

Gambar 19 Tampilan Running simulator pada inputan tabel kebenaran rangkaian AND di DSCH 

Tabel 10 Tabel Kebenaran Rangkaian AND 

Inputan 1 (in1) Inputan 2 (in2) Output (Out1) 

1 1 1 
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1 0 0 

0 1 0 

0 0 0 

 

PERCOBAAN 2 

Buatlah rangkaian OR dan Not pada DSCH dengan mengikuti langkah-langkah pada PERCOBAAN 1. 

Lakukan simulasi dan isilah tabel kebenaran berikut : 

Tabel 11 Tabel Kebenaran Rangkaian OR 

Inputan 1 (in1) Inputan 2 (in2) Output (Out1) 

1 1  

1 0  

0 1  

0 0  

 

Tabel 12 Tabel Kebenaran Rangkaian NOT 

Inputan 1 (in1) Output (Out1) 

1  

0  

 

PERCOBAAN 3 

Buatlah skema rangkaian logika seperti gambar dibawah ini pada DSCH2, kemudian isilah tabel 

kebenarannya ! 

 

Gambar 20 Rangkaian skema 2 kombinasi dengan 2 inputan 

Tabel 13 Tabel Kebenaran Rangkaian Kombinasi 

A B Y 

1 1  
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1 0  

0 1  

0 0  

 

1.7. TUGAS 

Buatlah skema rangkaingan logika kombinasi dengan 4 masukan seperti gambar dibawah ini dah 

buatlah juga Tabel Kebenarannya ! 

 

Gambar 21 Rangkaian skema logika kombinasi dengan 4 inputan. 

 

1.8. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-

KU01 

CPMK-03 Gambarkan gerbang logika di bawah ini untuk  

Y = (A . B) + (A . B) 

20 

2. CPL 03-

KU01 

CPMK-03 Sederhanakan rangkaian dibawah ini dengan aljabar 

boolen dan gambarkan rangkaian hasil 

penyederhanaannya 

 

 

 

50 
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3. CPL 03-

KU01 

CPMK-03 Sederhanakan dengan K-Map dan gambarkan 

rangkaian sebelum dan sesudah disederhanakan 

f =  m (0,1,2,4,6) 

30 

  

 

1.9. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-03    

2. Praktik CPL 03-

KU01 

CPMK-03    

3. Post-test CPL 03-

KU01 

CPMK-03    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 8 : GERBANG LOGIKA 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 9: FLOWCHART RUNTUTAN 

 

Pertemuan ke  : 9 
 
Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 
 
Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 
 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-04 Mampu merumuskan representasi pengetahuan menggunakan logika proposisional 

dan predikat, menerapkan penyelesaian masalah sederhana dengan konsep runtutan 

dan pemilihan  

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa mampu: 

1. Mengenal dan menggunakan raptor.  

2. Mampu menerapkan struktur dasar algoritma yang terdiri atas runtunan, pemilihan dan 

pengulangan serta mempelajari bagan atau simbol untuk menuangkannya dalam flowchart. 

 

1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -04 Mampu merumuskan representasi pengetahuan menggunakan logika 

proposisional dan predikat, menerapkan penyelesaian masalah 

sederhana dengan konsep runtutan dan pemilihan --> taksonomi bloom 

penerapan 
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Indikator ketercapaian diukur dengan: 

1. Menganalisa logika kasus dengan flowchard 

2. Membuat flowchart untuk penyelesaian permasalahan sederhana dengan konsep runtunan 

 

1.3. TEORI PENDUKUNG 

A. Pendahuluan Flowchart  

Tiga unsur dasar dalam algoritma yaitu runtun, pemilihan dan pengulangan. Runtun 

menyatakan bahwa tahapan dilakukan secara urut untuk menyelesaikan suatu masalah.  Kondisi 

atau pemilihan adalah tahapan proses untuk memilih proses yang akan dikerjakan berdasarkan 

kondisi yang sesuai dengan data.  Pengulangan menyatakan ada beberapa proses yang 

dilaksanakan berulang kali. Aliran data dapat disajikan dalam bentuk flowchart. Simbol yang 

diperlukan diantaranya :  

Tabel 14 Bagan Flowchart 

 

 

Gambar 22 Flowchart penjumlahan bilangan bulat 
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1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Raptor 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 03-

KU01 

CPMK-04 1. Buatlah Flowchart untuk menghitung jumlah dari 3 

bilangan yang diinputkan. 

50 

2. Buatlah Flowchart untuk menghitung volume balok. 50 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

1. CPL 03-

KU01 

CPMK-04 Selesaikan langkah praktikum Hasil dokumentasi praktikum 100 

 

2. Langkah- langkah Praktikum 

a. Penyelesaian masalah dengan flowchart akan menggunakan software Raptor.  

 

Gambar 23 Halaman Utama Raptor 
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b. Pada halaman utama Raptor, akan terlihat beberapa bagan untuk membuat flowchart.  Pilih 

simbol input, akan ditandai dengan warna merah, kemudian arahkan pointer di bawah simbol 

start. 

 

Gambar 24 Tampilan setelah menambahkan simbol input 

c. Tuliskan pada bagian “enter prompt here” dengan teks yang akan tampil di layar, dan “enter 

variable” dengan variabel untuk menyimpan data input.  

 

Gambar 25 Tampilan isian input 

d. Lanjutkan untuk input variabel yang kedua.  Untuk membuat proses dalam flowchart, pilih 

simbol persegi.  Isi “Set” dengan nama variabel untuk penyimpanan data hasil dari proses.  Isi 

“to” dengan instruksi atau kalimat proses.  
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Gambar 26 Tampilan isian prosesLanjutkan dengan menambahkan simbol output. 

 

Gambar 27 Tampilkan isian output 

e. Flowchart telah selesai selanjutnya menjalankan raptor untuk membuktikan apakah 

flowchart telah sesuai.  Tekan tombol “execute to completion”.  Lakukan sesuai instruksi.  

Raptor akan menampilkan hasil benar jika flowchart sesuai, namun akan menampilkan pesan 

error jika flowchart belum sesuai.  Kita dapat memperbaiki kembali flowchart sampai sesuai.  
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Gambar 28 Tampilan input bilangan pertama 

 

Gambar 29 Tampilan input bilangan kedua 



91 
 

Logika Informatika - Informatika – UAD - 2023 
 

 

Gambar 30. Tampilan output jumlah 2 bilangan 

Contoh : 

1. Flowchart di Raptor untuk Konversi cm ke inchi  

 

 

 

 

 

 

 

 

 

2. Flowchart menghitung volume balok.  
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1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-

KU01 

CPMK-04 Buatlah program dengan maple untuk menghitung 

usia berdasarkan tahun (saja) lahir dan tahun (saja) 

sekarang 

Input : Tahun lahir (tl), Tahun  sekarang (ts) 

Proses  : Umur = ts –tl  

Output : Cetak Umur  

75 

2. Gambarkan dan buktikan flowchart anda benar 

dengan raptor 

25 

  

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-04    

2. Praktik CPL 03-

KU01 

CPMK-04    

3. Post-test CPL 03-

KU01 

CPMK-04    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI PRAKTIKUM 9: FLOWCHART RUNTUTAN 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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PRAKTIKUM 10: FLOWCHART LANJUTAN (KONSEP PEMILIHAN DAN 

PENGULANGAN) 

 

Pertemuan ke  : 10 

 

Total Alokasi Waktu : 90 menit  

• Pre-Test  : 10 menit 

• Praktikum  : 60 menit 

• Post-Test  : 20 menit 

 

Total Skor Penilaian : 100%  

• Pre-Test  : 20 % 

• Praktikum  : 30 % 

• Post-Test  : 50 % 

Pemenuhan CPL dan CPMK: 

CPL 03-

KU01 

Mampu menerapkan pemikiran logis, kritis, sistematis dan inovatif dalam konteks 

pengembangan atau implementasi ilmu pengetahuan dan teknologi yang 

memperhatikan dan menerapkan nilai humaniora yang sesuai dengan bidangn 

rekayasa perangkat lunak serta data dan sistem cerdas maupun bidang lainnya 

CPMK-04 Mampu merumuskan representasi pengetahuan menggunakan logika proposisional 

dan predikat, menerapkan penyelesaian masalah sederhana dengan konsep runtutan 

dan pemilihan 

 

1.1. DESKRIPSI CAPAIAN PEMBELAJARAN 

Setelah mengikuti praktikum ini mahasiswa diharapkan:  

1. Mampu menyelesaikan permasalahan sederhana dengan menggunakan flowchart dan raptor . 

2. Mampu menyelesaikan permasalahan studi kasus pemilihan dan pengulangan menggunakan 

flowchart raptor. 
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1.2. INDIKATOR KETERCAPAIAN PEMBELAJARAN 

CPL 03-

KU01 

CPMK -04 Mampu merumuskan representasi pengetahuan menggunakan logika 

proposisional dan predikat, menerapkan penyelesaian masalah 

sederhana dengan konsep runtutan dan pemilihan --> taksonomi bloom 

penerapan 

 

Indikator ketercapaian diukur dengan: (sesuaikan dengan RPS) 

1. Flowchart dengan Raptor (studi kasus pemilihan dan pengulangan). 

 

1.3. TEORI PENDUKUNG 

Kondisi atau Pemilihan dalam Flowchart  

Tiga unsur dasar dalam algoritma yaitu Runtun, pemilihan dan pengulangan.  Runtun menyatakan 

bahwa tahapan dilakukan secara urut untuk menyelesaikan suatu masalah.  Kondisi atau pemilihan 

adalah tahapan proses untuk memilih proses yang akan dikerjakan berdasarkan kondisi yang sesuai 

dengan data.    

Contoh :    

Konversikan nilai angka menjadi nilai huruf dengan ketentuan sebagai berikut : 

 

Langkah Flowchart: 
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Gambar 31 Flowchart konversi 

 

1.4. HARDWARE DAN SOFTWARE 

Alat dan bahan yang digunakan dalam praktikum ini yaitu: 

1. Komputer. 

2. Software Raptor 

 

1.5. PRE-TEST 

Jawablah pertanyaan berikut (Total skor: 100) : 

CPL CPMK No. Pertanyaan Skor 

CPL 03-

KU01 

CPMK-04 1. Buatlah Flowchart untuk mengkonversi hari ke-1 adalah 

hari senin sampai dengan hari ke-7 adalah hari Minggu. 

Misalnya dimasukkan nilai 5 outputnya adalah Jumat. 

100 

 

1.6. LANGKAH PRAKTIKUM 

1. Aturan Penilaian (Total Skor : 100) 

No CPL CPMK Pertanyaan Dokumen Pendukung Skor 

4.  CPL 03-

KU01 

CPMK-04 Selesaikan langkah praktikum Hasil dokumentasi 

praktikum 

100 
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2. Langkah-langkah Praktikum 

Sama halnya seperti pada praktikum sebelumnya, pada praktikum kali ini akan diperlihatkan contoh 

penggunaan tool selection dan looping.    

Contoh :   

1. Menentukan bilangan ganjil genap  

 

Gambar 32 Flowchart menentukan bilangan ganjil dan genap 

2. Menentukan bilangan terbesar antara 3 bilangan bulat  

 

Gambar 33 Flowchart menentukan bilangan terbesar 3 bilangan bulat 
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Gambar 34 Tampilan flowchart konversi nilai 

 

 

 

 

Jalankan flowchart tersebut dengan menekan tombol execute.  Hasilnya terlihat seperti gambar di 

bawah  :  
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Gambar 35 Hasil eksekusi 

Masukkan nilai yang akan dikonversikan. Window master console menampilkan bahwa flowchart telah 

benar.  

 

Gambar 36 hasil eksekusi berhasil 

 

1.7. POST TEST 

Jawablah pertanyaan berikut (Total skor 100) : 



101 
 

Logika Informatika - Informatika – UAD - 2023 
 

No CPL CPMK Pertanyaan Skor 

1. CPL 03-
KU01 

CPMK-04 Buatlah Flowchart dan program di maple untuk 
mengkonversi tahun kabisat atau bukan tahun kabisat. 

50 

2. CPL 03-
KU01 

CPMK-04 Buatlah flowchart untuk proses membuat kopi dengan 
urutan kegiatan sebagai berikut : 

- Ambil sebuah gelas. 

- Ambil dua sendok kopi bubuk, kemudian masukkan 
ke dalam gelas. 

-  Ambil tiga sendok gula pasir, kemudian masukkan 
ke dalam gelas. 

- Masukkan air ke dalam gelas secukupnya. 

- Kemudian diaduk-aduk memakai sendok. 

- Kemudian dicicipi rasanya. 

- Jika kurang manis, tambahkan satu sendok gula 
pasir. 

- Jika terlalu manis, tambahkan air sehingga rasa 
manisnya tepat. 

- Apakah manisnya cukup? Jika tidak maka kembali 
pada langkah g. 

- Jika ya maka jadilah segelas kopi dengan rasa manis 
yang tepat. 

50 

  

1.8. HASIL CAPAIAN PRAKTIKUM 

No. Result Assesment CPL CPMK Bobot Skor 

(0-100) 

Nilai Akhir 

(Bobot x skor) 

1. Pre-test CPL 03-

KU01 

CPMK-04    

2. Praktik CPL 03-

KU01 

CPMK-04    

3. Post-test CPL 03-

KU01 

CPMK-04    

Total Nilai  
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LEMBAR JAWABAN PRE-TEST / POST-TEST / EVALUASI FLOWCHART LANJUTAN (KONSEP 

PEMILIHAN DAN PENGULANGAN) 

Nama : 
NIM    : 
 

Asisten: 
Paraf Asisten: 

Tanggal: 
Nilai: 
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